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Objectives

= At the end of this presentation, you will understand:
- What memory leak is.

- What memory leak dump is and how to get it.
HPROF Binary Heap Dumps
What Garbage Collection Roots(GC roots) is
How to get memory leak dump for Android

- What DDMS memory tool is and how to use it to detect memory leak.
- What MAT is and how to use it to analyze memory leak.
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What’s Memory Leak
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What's Memory Leak

= In computer science, a memory leak occurs when a computer program
Incorrectly manages memory allocations.

= In object-oriented programming, a memory leak may happen when an
object is stored in memory but cannot be accessed by the running code.
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What’s Memory Leak for Android

= For Android (Java), "memory leak" in your code is when you keep a
reference to an object that is no longer needed. Sometimes a single
reference can prevent a large set of objects from being collected as
garbage.

= The memory allocated by Android application can be retrieved by the
Dalvik (Android process virtual machine) after the application exits. So
even the application has memory leak, after the application exits, the
leaked memory also can be retrieved.
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What’s Memory Leak for Android

= If the Android application needs to run for a long time without exiting, or
the application needs to allocate large memory, the memory leak will be a
problem.

= Every Android application is running in a separate thread. And every
application has the memory limitation.

= If the used memory is near the limitation, out of memory will appear, the
application will be killed.

= There are two most common memory leak types.

= The first one is a static reference to a non-static inner class, which will keep a
reference to the Activity and prevent it from being GC. Upon every screen
orientation change, the onCreate method will be invoked and a new MainActivity
iInstance will be created. Due to old references, the old Activities will not be
collected as garbage .

- The second case is known as a “context leak”. This case is hard to spot as the
main issue lies within the application’s context passed to a static class that
keeps it as a field — which of course is a hard reference.
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What's Memory Leak Dump
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What's Memory Leak Dump

= A memory dump is a snapshot of the memory of a Java process at a
certain point of time.

= There are different formats for persisting this data. Depending on the
format, it may contain different pieces of information. But in general the
snapshot contains information about the java objects and classes in the
memory at the moment the snapshot is triggered.

= As it is just a snapshot at a given moment, a memory dump does not
contain information such as when and where (in which method) an object
is allocated.
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HPROF Binary Heap Dumps

= Information about all loaded classes. For every class, the HPROF dump
contains its name, its super-class, its class loader, the defined fields for
the instances (name and type), the static fields of the class and their
values.

= Information about all objects. For every object, one can find the class and
the values of all fields — both references and primitive fields. The
possibility to look at the names and the content of certain objects, e.g. the
char[ ] within a huge StringBuilder, the size of a collection, etc. can be
very helpful when performing memory analysis

= Alist of GC roots.
= The call stacks of all threads.
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What's Garbage Collection Roots (GC roots)

= The Garbage Collector (GC) is responsible for removing objects that will
never be accessed.

= Objects cannot be accessed if they are not reachable through any
reference chain.

= The starting point of this analysis is the Garbage Collection Roots, i.e.
objects that are assumed reachable by the virtual machine itself.

= Objects that are reachable from the GC roots remain in memory, objects
that are not reachable are garbage collected.
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What's Garbage Collection Roots(GC roots)

= Common GC Roots are objects on the call stack of the current thread (e.g.
method parameters and local variables), the thread itself, classes loaded
by the system class loader and objects kept alive due to native code.

= GC Roots are very important when determining why an object is still kept
iIn memory: The reference chain from an arbitrary object to the GC roots
(Path to GC Roots...) tells who accidentally keeps a reference.
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How to Get Memory Dump?

= We can get the *.hprof (memory dump file) with one of the ways below:
- In DDMS, select ‘Update Heap’ and ‘Dump HPROF file’ can get the *.hprof file.

= Call the function ‘adroid.os.Debug.dumpHprofData("/data/temp/myapp.hprof");’
can save the *.hprof file to a folder in the device.

= Dalvik VM will dump hprof file within /data/misc folder if SIGUSR1 and/or
SIGQUIT signal is received. Manually send SIGUSRL1 to process: kill -10 pid.
(Before Android 2.3)

= The Android provides monkey tool (random testing tool), with --hprof option will
generate hprof file within /data/misc folder.

= The folder /data/misc shall have 777 permissions.
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How to Get Memory Dump?

File Edit Mavigate Search Project Run  Window Help
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@D 22| O @ il T B E-&|Q
= . -
i Overview [ default_report org.eclipse.mat.apisuspects 52 l Heap updates will happen after every GC for this client
MName - D Heap Size Allocated Free % Used # Objects
4 [@ MSMB625QRD5 Online | | PEoE Suspects LT TA 36 ME. | 9.034 ME 5282 MB . 63.10% 41630 ¢ | Caus
com.android.launcher 576 (
com.android.providers.calendar 1223 ‘@ SuspeCtS Displa
com.android.musicfx 12075 L
android.process.acore 9229 Svstem ovewiew Type Count Total Size Smallest
com.qualcomm.stats 1024 free 3582  521TMB 168 :
com.android.contacts 9171 -
— data object 27,251 838273 KB 16B
: - Leaks ) -
com.android bluetooth 1393 class object 2706 804430 KB 168 B 3
C°m'?”d’°'d:m"?“‘h ﬂ;m Overview 1-byte anay (bytel], boolean(]) 620  6533MB 4B 1
-
c°"”"””d°pf": "":tt"'ec_are 1o 2-byte array (short{], char[]) 9717  628.727KB 4B 2
Ez::: d:z: d:mir::rl 206 4-byte array (object]], int[], float]) 4,252  283.461 KB 4B 1
com.android.music 1172 8-byte array (long[], doublel]) 24 0.203 KB 24B
android.process.media 529 non-lava chject 127 5453 KB 168
com.qrd.simcontacts 12125 (2) 6.6 ME
com.android.phone 561
com.android.settings 1143
system_process 332
com.android.qualcomm 9267
com.android.inputmethod.latin - 542
com.android.gallery3d 997
4 m
Allocation count per size
1.00
0.75
=
i § 0. 50
Total: 8.4 MB o
0.25
~ @ Problem Suspect 1
i 0. 00
< | m | N 1 | b Size
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How to Get Memory Dump?

= If the *.hprof can’t be recognize by the MAT(Memory Analyzer Tool), we
need to convert it as below:

sdk\tools\hprof-conv a.hprof b.hprof
Now the ‘b.hprof’ can be used in the MAT.
‘hprof-conv’ is a tool including in Android SDK.
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DDMS Memory Tool
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DDMS Memory Tool

= Android ships with a debugging tool called the Dalvik Debug Monitor
Server (DDMS), which provides port-forwarding services, screen capture
on the device, thread and heap information on the device, logcat, process,

and radio state information, incoming call and SMS spoofing, location data
spoofing, and more.
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Viewing Heap Usage for a Process

- DDMS allows you to view how much heap memory a process is using.
This information is useful in tracking heap usage at a certain point of time
during the execution of your application.

= To view heap usage for a process.:

1)  In the Devices tab, select the process that you want to see the heap
information for.

2)  Click the Update Heap button to enable heap information for the process.

3) Inthe Heap tab, click Cause GC to invoke garbage collection, which enables
the collection of heap data. When the operation completes, you will see a
group of object types and the memory that has been allocated for each type.
You can click Cause GC again to refresh the data.

4)  Click on an object type in the list to see a bar graph that shows the number of
objects allocated for a particular memory size in bytes.
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Viewing Heap Usage for a Process

File Edit Source Refactor Navigate Search Project Run  Window Help
Ch = b= @ [1] - -q - [ Quick Access [ ﬁ| & Java £, Memory Analysi:
B Devices 2 g |&)@ | g 4 | o] | @l @| i = = 8 || [5] Main | Z, Thread Heap ESD Allocation Tracker | =™ Metwork Statistics|lﬁl File Explorer|® Emulator Contr0|| = I
MName PA¢| Heap updates will Rappen after every GC for this client
4 @ MsMas25QRDS Online 404, debug @imp| ID  HeapSize  Allocated Free %Used  #Objects
com.android.launcher 276 8600 1 14316MB  8326MB  5390MB  6235% 42,634
com.android.systermui 494 &a01 puk
android.process.media 529 8603
i - Display: |Stats =
com.android.phone 561 8604 al oy
systenj_process 332 8605 Type Count Total Size Smallest Largest Median Average
android.process.acore 603 8606
com.androidinputmethod.latin - 542 8607 . 347 168 4828 MB 08 1714 KB
com.android.smspush 673 8608 Z0.00) L bl S22 2L
com.qrd.simcontacts 597 8609 = JeeThject 2,620 TIOTE 168 B 38,180 KB 168 B 3028
com.android.contacts 771 8610 - 1-byte array (byte[], boolean[]) 675 6.533 MB 24B 1.000 MB 416 B 9.910 KB
com.qualcomm,CellBCSetting 893 8514 2-byte array (short], char(]) 9308 601148 KE 24 B 28,022 KB 48B G6 B
com.android.gallery3d 297 8620 4-byte array (object[], int[], float[]) 4,015  264.758 KB 24B 16.023 KB 40B 67 B
com.qualcomm.stats 1024 8621 8-byte array (long[], double[]) 16 5547 KB 248 4,000 KB 128 B 355B
com.android.musicfx 1098 8624 ) non-Java ohject 127 5453 KB 16 B 464 B 32B 43 B
com.android.qualcomm 1112 8625
com.qualcomm.restore.airplaner 1129 8602
com.android.settings 1143 8626
com.android.veicedialer 1138 8639
com.android.music 1172 8649 / 8700
com.android.deskclock 1185 8656
com.android.calendar 1206 8665
com.android.providers.calendar 1223 8667
com.android.bluetooth 1393 8669
Allocation count per size
17, 500
13, 000
12, 500
t 10,000
2
o 7, 300
I, OO0,
2, 500,
P T e e m e M T § = = = = = = = =
Size
E)
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Viewing Heap Usage for a Process

In this heap view, there is a type called ‘data object’, we should pay
attention to the ‘Total Size’ of this type.
We can make different operations in our application and check the size.

- If there is no memory leak, the size will keep in a range.
= If the size increases continuously, there should be memory leak.

| MAY CONTAIN U.S. AND INTERNATIONAL EXPORT CONTROLLED INFORMATION
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Tracking Memory Allocation of Objects

- DDMS provides a feature to track objects that are being allocated to
memory and to see which classes and threads are allocating the objects.
This allows you to track, in real time, where objects are being allocated
when you perform certain actions in your application. This information is
valuable for assessing memory usage that can affect application
performance.

= To track memory allocation of objects:

1)  In the Devices tab, select the process that you want to enable allocation
tracking for.

2)  In the Allocation Tracker tab, click the Start Tracking button to begin
allocation tracking. At this point, anything you do in your application will be
tracked.

3) Click Get Allocations to see a list of objects that have been allocated since
you clicked on the Start Tracking button. You can click on Get
Allocations again to append to the list new objects that that have been
allocated.

4)  To stop tracking or to clear the data and start over, click the Stop Tracking
button.

5)  Click on a specific row in the list to see more detailed information such as the
method and line number of the code that allocated the object.
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Tracking Memory Allocation of Objects

File Edit Source Refactor Navigate

Search Project Run  Window Help
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480 3952 char] 1 java.lang.AbstractStringBuilder enlargeBuffer

191 2038 char]] 1 javaang.AbstractStringBuilder 7 erlargeBite,
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492 1362 char] 1 java.lang.AbstractStringBuilder er
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424 160 int[] 1 java.lang.Throwable nativeFilllnStackTrace
423 160 int[] 1 java.lang.Throwable nativeFilllnStackTrace
12 160 int[] 1 java.lang. Throwable nativeFilllnStackTrace
411 160 intf] 1 java.lang.Throwable nativeFilllnStackTrace
326 160 int[] 1 java.lang.Throwable nativeFilllnStackTrace
477 154 char] 1 java.lang.AbstractStringBuilder enlargeBuffer

472 144 int[] 1 java.lang. Throwable nativeFilllnStackTrace
167 144 javalang.Object[] 9 java.lang.ThreadLocalSValues initializeTable
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505 114 char] 1 android.os.Parcel readString

AT 108 rharll 1 iaura lama Chrina simitn

Class Method File Line Native

android.os.Parcel readString Parcel java -2 true
android.app.ApplicationErrorReportSC...  <init> ApplicationErrorReport. gt 372 false
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com.android.music.MediaPlaybackSer.. notifyChange MediaPlaybackService java 885 false
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android.app.ActivityThread handleCreateSer...  ActivityThread.java 2261 false
android.app.ActivityThread accessS1600 ActivityThread.java 126 false
android.app.ActivityThreadSH handleMessage ActivityThread,java 1209 false
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MAT (Memory Analyzer Tool)
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MAT (Memory Analyzer Tool)

= The Eclipse Memory Analyzer Tool is a fast and feature-rich Java heap
analyzer that helps you find memory leaks and reduce memory
consumption.

- Use the Memory Analyzer Tool to analyze productive heap dumps with
hundreds of millions of objects, quickly calculate the retained sizes of
objects, see who is preventing the Garbage Collector from collecting
objects, run a report to automatically extract leak suspects.

= The Dalvik virtual machine can produce a complete dump of the contents
of the virtual heap. This is very useful for debugging memory usage and
looking for memory leaks.
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Install MAT

= We can get the MAT from below URL.:
http://www.eclipse.org/mat/

Get the correct version and install it from eclipse.

About This Project

Memory Analyzer »»

Screenshots
Getting Started
Documentation
FAQ (Wiki)
Forum

Blog

Unresolved bugs and
enhancements

Report Bug
Downloads -

Releases

Nightly Builds
Contributors »»

Contributor
Reference
Mailing Lists
View SWN
Project Plan
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Manager).
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= Eclipse Summit Europe
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[E] mac OsXiMac/Cocoa x26) (45 MB) A o ticklerian. Tay 08
[E] mac 0SX (Mac/Cocoa x86_64) (45 MB) = Andrena Entwickiertag, May
[El Linux (x286/G6TK 2) (46 MB) m JAX, April ‘08
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Confidential and Proprietary — Qualcomm Technologies, Inc. | MAY CONTAIN U.S. AND INTERNATIONAL EXPORT CONTROLLED INFORMATION


http://www.eclipse.org/mat/

Load Dump File

= In eclipse, select ‘Memory Analysis’ tool, select the dump file by click the
menu ‘File > Open Heap Dump’, select the ‘Leak Suspects Report’ in the
‘Wizard’ dialog as below and click ‘Finish’, after a delay, the Leak
Suspects report will appear.

File Edit MNavigate Search Project Run Window Help
B v p@ 8 Q- [ .y S - | Quick Access [ E | & ava 8D Memory Analysis >
= T
[, Inspector 22 B = O MainActivity.java android240576570741260554 hprof &2
P = ty.j P

ioml e ol | MEl- B -] Q &=
e, W A

~ Details

— _
(@) Getting Started Wizard wtn = |

Getting Started

Choose one of the common reports below, Press Escape to close this dialog.

=
Statics | Attributes | Class Hierarchy | Value = < @ Leak Suspects Report

Type MName Value eap dump for leak suspects. Report what objects are kept

alive and why they are not garbage collected. l 4.2 MB
) Component Report

Analyze a set of objects for suspected memory issues: duplicate strings, empty
collections, finalizer, weak references, etc.

) Re-open previously run reports

Existing reports are stored in ZIP files next to the heap dump.

Show this dialog when opening a heap dump.

@) < Back Mext > Finish ] [ Cancel ]

~ Step By Step

il Histogram: Lists number of instances Leak Suspects: includes leak suspects Component Report: Analyze objects which
per class and a system overview belong to a commeon root package or class
% Dominator Tree: List the biggest objects Top Components: list reports for er.
and what they keep alive. components bigger than 1 percent of

Top Consumers: Print the most the total heap.

expensive objects grouped by class
and by package.

Duplicate Classes: Detect classes loaded
by multiple class loaders.
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The Leak Suspects Report

The report will generate a graph indicating things it thinks may be memory
leaks.

Leak Suspects include leak suspects and a system overview.
Not everything it thinks may be a leak actually is.

What you really need to suspect is things that have multiple instances
allocated or things which are using huge amounts of memory.
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The Leak Suspects Report

Eile Edit Mavigate 5earch Project Bun  Window Help

il Q- [ B AR =T v| + Quick Access I ﬁl &) Java @ DDMS E Memaory Analy
=4 Inspector 3@] <f;> = B || [J] MainActivityjava IE android240576570741 260554 hprof 232 l @ android1373813633317141066.hprof |§ android507078783642344019. hprof | = g

il B E & Q
i Overview default_report org.eclipse.mat.apiisuspects 23 l %g dominator_tree| fez, path2gc [selection of 'MessagelistView @ 0x42b44348'] —e...| nl Histogram|

-

Leak Suspects

System Overview
~ Leaks
Statics | Attributes| > #
Type  Name Value + Overview
(k) 32MB =
() SME
(&) 42 MB
4 1 3
B (=) Problem Suspect 1
EZ. Mavigation History 52 = O W k) Problem Suspect 2
a4 1 OverviewPane B o) Problem Suspect 3 B
4 l%g dominator_tree [ (o Remaincer
ks path2ge| tion of ‘Reciy]
ks pathZg
s pathlg [
Irs, path2gc [selection of ‘Mess
histogram
bl : (@ 163M8 —

default_report org.eclipse.mat.ap)

Total: 26.5 MB

+ @ Problem Suspect 1

The class "android.content.res.Resources", lcaded by "<system class loader=",
: occupies 4,419,568 (15.73%) bytes. The memory is accumulated in one instance of
i "java.lang.Object[]" loaded by "<system class loader>".

Keywords
i java.lang.Object[]
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The Leak Suspects Report

= Clicked on the Detalls link. This causes three more reports to appeatr:
‘Shortest Paths To the Accumulation Point’, ‘Accumulated Objects’,
‘Accumulated Objects by Class'.

= Shallow size of an object is the amount of memory allocated to store the
object itself, not taking into account the referenced objects. Shallow size
of a regular (non-array) object depends on the number and types of its
fields. Shallow size of an array depends on the array length and the type
of its elements (objects, primitive types). Shallow size of a set of objects
represents the sum of shallow sizes of all objects in the set.

= Retained size of an object is its shallow size plus the shallow sizes of the
objects that are accessible, directly or indirectly, only from this object. In
other words, the retained size represents the amount of memory that will
be freed by the garbage collector when this object is collected.
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The Leak Suspects Report

Window Help

AW~ ® P

Quick Access

%’| &) Java ¥ DDMS E Memory Analy:

File Edit Mavigate Search Project Run
-
[Z tnspector &2 l g = B

[1] MainActivity.java [@ android240576570741260554 hprof &2 ] £ android1373813633317141066.hprof |§ android507078783642344019.hprof | = g

ioml s B EB | Q

Statics | Attributes | >z -

Type Mame Value

4 1L} 2

=

B Mavigation History &2 l

a4 1 OverviewPane

Fl dominator_tree

selection 9’ Com

ks pathlgc [selection of ‘Mess
Il histogram
default_report org.eclipse.mat.ap
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i Owverview l default_report org.eclipse.mat.apitsuspects &2 l l%g dominator treel = path2gc [selastiorei-iviessagetistibona® 0l 2b44348] -e.. | nl Hlstograml
Class Name Shallow Heap Retained Heap ) Percentage
JE class android.content.res.Resources @ 0x410cSb70 % 15.73%
i..[(Landroid. util.| ongSparseArray @ Ox410e5178 24 4,415,976 15.72%
------ Dmva lang.Object[510] & 0x418214a0 2,056 4,411,856 15.70%
[landrmd graphics.Bitmap @ 0x41295a98 48 155,200 0.55%
android.graphics.Bitma 0x41296f00 438 155,200 0.55%
Qandrold graphics.Bitmap @ 0x41298230 48 155,200 0.55%
android. graphics.Bitma 0x41298cc0 48 155,200 0.55%
android.graphics.Bitmap @ 0x412a6a58 48 155,200 0.55%
android. graphics.Bitma 0x412b1b78 48 155,200 0.55% L
i [ jandroid.graphics.Bitmap @ 0x412b20e8 43 155,200 0.55%
android. graphics.Bitma 0x412b2328 48 155,200 0.55%
:----D@dmid.qr@hics.BitnEp @ Ox412a0120 43 52,480 0.33%
android.graphics.Bitma 0x4412a0880 48 52,480 0.33%
. ['Jandroid. graphics.drawable.NinePatch DrawablesNinePatchState @ 0x41875bca 32 86,280 0.31%
android.graphics.drawable.MinePatchDrawablesNinePatchState @ 0x41296228 32 86,264 0.31% i
D@droid.qrgphics.drawabIE.NinePatchDra\-vabIeSNinePatchState @ 0x418601d0 32 86,264 0.31% 1
android.graphics.drawable.NinePatchDrawablesNinePatchState @ 0x4188ad58 32 86,264 0.31%
android.graphics.drawable.NinePatchDrawablesMinePatchState @ 0x4124b0b0 32 61,768 0.22%
android.graphics.drawable.NinePatchDrawablesNinePatchState @ 0x412aSbed 32 61,768 0.22%
[landroid.qrgphics.drawable.BitmaDDrawable$BitmaDState @ 0x412850b0 40 43,720 0.16%
- [ ‘Jandrgid.graphics.drawable.BitmapDrawable$BitmapState @ 0x41288990 40 43,720 0.16%
[landroid.qrgphics.drawahlE.NinePatchDra\-vableSNinePatchState @ 0x412a02b8 32 37,904 0.13% T
i-.. [jandroid.graphics. Bitmap @ 0x41230420 43 36,928 0.13%
i..¥ Total: 20 entries 832 2,057,440 0.073
~ Accumulated Objects by Class
Label < MNumber of Objects > Used Heap Siz< Retained Heap Size>
:@—q—p—ﬂﬁi':gﬁg-“;aﬁ hics.Bitma 54 3,072 2,229,792
IF1android. araohics.drawable.NinePatchDrawables NinePatchState - o ———am
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Histogram View

= Analyze the results using the Histogram view.
= Histogram lists number of instances per class.
= ldentifies types of objects allocated.
- Doesn't know whether they will eventually be freed.

- We must compare two HPROF snapshots to identify which objects are
responsible for a leak.
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Histogram View

Eile Edit [Mavigate Search Project Bun  Window Help
£ - p@ 3 Q - [ I B vl il Quick Access I E}| 3’3’ Java 3 DDMS E Memory An
[Z Inspector &1 & = B || [ MainActivityjava £ android240576570741260554.hprof &1 i =

@ 0541052468

Jc| Bitrap

B3 android.graphics

A2 class java.lang.Class @ 0x410341 e
%java.lang.Object

@java.lang.ClassLnader @ 040

10124 (shallow size)

101168 (retained size)

o 0OC root: Unknown, Systern Class, Mative Stack

Statics | Attributes | Class Hierarchy | Value

Type Mame WValue

ref SstaticOve...

ref CREATOR android.graphics.Bitmap$1 &

int DENSITY.... o

int WORKING... 4096

int sDefoultD... 320

ref sScaleMatrix  android.graphics.Matroe @ C:
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iml Bw @ E-R-Q|HF-EB-a-| &

i Overview default_report org.eclipse.mat.apiisuspictsI% dominator_tree | =2 path2gc [s i . istView @ Owd... | [l Histogram &
Objects Shallow Heap Retained He

Class Mame
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p o <Mumeric> <Murmeric> <Murmeric>
< LC) byte[] > 2,049 15,076,672 »=15,076,672
({2 android.graphics.Bitmap 389 18,672 >= 14,552 688 |
C] java.lang.Class 3,627 90,320 == 7,898,920
C] andreid.graphics.drawable.BitmapDrawable 4949 316,736 >= 5,766,776
[C] com.andreid.mms.ui.Messagelistitern 56 34944 >= 5,676,728
[C] android.widget ImageView 748 311,168 =»= 5,661,640
[C] java.lang.Object]] 6,699 319,360 »= 5101424
{3 android.content.res.Resources 2 144 »=4 444 584
C android.util. LongSparsefrray 9 216 »= 4,428,144
@ android.view.View(] 2,338 137,784 == 2,908,856
C] android.graphics.MinePatch 932 29824 == 2 750,808
C] com.andreid.mms.ui. ComposeMessagelctivity 23 13,984 »>= 2731144
C] android.widget.LinearLayout 1,074 549 888 == 2634176
C] java.util.HashMap 1,323 63,504 >= 2515720
C] java.util.HashMapSHashMapEntry([] 907 89832 >= 2,515,296
3 java.util. HashMapSHashMapEntry 6,720 161,280 »= 2,443 408
[C] com.android.mms.ui.MessagelistView 23 21,896 »>= 2,430,720
& com.android.mms.ui.ConversationListltern 127 69088 == 2197 880
[C] java.util.HashSet 35 560 »= 2 116,656
{3 com.android.mms.data.Contact 9 720 == 2,085,264
C] android.graphics.drawable.StateListDrawable 1,482 142 272 »= 1,080,104
@ int[] 12,839 1,633,360 »=1,633,360
C] java.lang.5tring 29,032 696,768 =>=1,632904
C] android.widget. TextView 1,145 705,320 »=1,463512
C] andreid.graphics.drawable.5tatelistDrawableSStatelistState 1,482 118,560 »>=1,299592
C] andreid.graphics.drawable.Drawable[] 1,535 94 016 >=1,152,280
@ char] 20,261 1,059144 »=1,059,144
3 android.content.res. TypedArray 250 10,000 »=1,011,504
{3 android.graphics.drawable.NinePatchDrawableSNinePatc... 932 29824 »= 985,832
& com.android.mms.isms.ui.view.NmsEmoticonPanel 23 15272 == 957,520
(C] com.android.mms.ui.RecipientsEditor 5 4,240 == 902504
C] android.widget. AdapterViewSAdapterContextMenulnfo 4 96 >= 739,192
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Histogram View

The ‘byte[ |’ costs most of the heap, so right click on it and select ‘List

Objects > with incoming references’, from this, we can find which object

the data belong to.

PAGE 35

Eile Edit— Navigate — Scarch— Project— Run Window— Help

oo p@ 2 Q- = P - - v| o Quick Access
-

= Inspector 23 4:'4) = O [J] MainActivity.java android240576570741260554 . hprof 23 androidl373813633317141066.hprof
b

@ 0x42417668

[7] ImageAttachmentView

# com.android.mms.ui

JE| class com.android.mms.uidmageAt...
%android.widget.LinearLayout

Al dalvik.system.PathClassLoader @ Ox...
3_ 528 (shallow size)

1[1639,056 (retained size)

o ho GC root

Statics | Attributes | % rd
Type Mame Walue -+
ref mGifView null | |
ref mlmageVi.. android.widg'—
ref mLinearLa... null
ref mMaxDes... int[4] @ 0xd2¢
ref mMaxAsc...  int[4] @ Dxd2¢
ref mDivider null
int mBaseline.. 0
int mDividerH... 0 2
[ W 3

B~ Mavigation History 22

T dul

i Owverview %gdominator_tree

W E - & A E -]

Histagram | [F] list_objects [selection of ‘byte[]'] -inbound 53

Class Mame

- T mBitmap android.graphics.drawable.BitmapDrawable @ 0x41a552e3
T mBitmap android.graphics.drawable.BitmapDrawable @ 0x41a556f8
- T mBitmap android.graphics.drawable.BitrnapDrawable @ Ox4labccal
T mBitmap android.graphics.drawable.BitmapDrawable @ Ox41a5d190
T mBitmap android.graphics.drawable.BitmapDrawable @ 0x41a79330
> D mBltmap android. graphlcs drawable. BltmapDrawable @ 0xdla7cBdE

80-NJ221-1 A

a i OwverviewPane
4 Fs dominator_tree

g
Il histogram
default_report on
%g dominator_tree

4 il histogram

[P list_chjects [selection of by

default_report or

Jul 2013

- D mImageView com.android.mms.uilmageAttachmentVi @ 0x42417668

- D mParent android widgetImageView @ 0:x42442868

> Tl [0] android.view.View[12] @ 0x42332a68
T mCaller android.view.InputEventConsisteg
ol

erifier @ 0x42332b40

. ] mParent android.widget.LinearLayout @ 04233340

> mView com.android.mms.ui.AttachmentEditor @ 0x42331060

[1] android.view.View[12] @ (ke 2cdfled

mParent android.widget.LinearLayout @ 0:x42332cd0

mdCaller android.view.InputEventConsistencyVerifier @ 0:42417898
mView com.android.mms.ui.MmsThumbnailPresenter @ 0:x422d46d0
referent java.lang.ref. WeakReference @ 042332940

+hichll andraid view VieadGrannS2 @ (A ?227a58

o0oDED
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B android507078783642344019. hprof

Shallow Heap
64
64
64
64
64
64
64

626,536
48

64

416
624

64

80

24

24

40

526,536
45

G4

416

528

416

528

64

80

24

512
544
64
512
80
32
24
1R

[ & | & Java @& DDMS [E5, Memory Analys

= &

Retained He =

626,
626,
626,
627,
639,
627,
639,

10,.

m
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Dominator Tree

Dominator Tree will list the biggest objects and what they keep alive.

File Edit Mavigate Search Project Run  Window Help
5 v @ 3 Q - & v o v| ] Quick Access [ ﬁ| &) Java ¥ DDMS @
=4 Inspector 22 Q==(> = 8 [J] MainActivity.java g android240576570741260554 hprof ESTE androidl373813633317141066. hprof g android507078783642344019 hprof = &
@ 0dlc5c2c0 iom R | E-B-|QHE A~ @
[] ComposeMessagehctivity - . - W -
£ com.android.mms.ui 1 Owverview %g dominator_tree 2 9 .
@ class com.android.mms.ui.Compos... Class Mame Shallow Heap Re‘ta;ned Heap Percentage ol
@android.app.Activit}r :{='=> <Regex> <Murmeric> =Murmeric> <Murneric>
&0] dalvik.systemn.PathClassLoader @ Ox... > M| class android.content.res.Resources @ 0x410c9b70 Unknown, System Class 43 4,419,568 15.73%
10608 (shallow size) > J,E:I class com.android.mms.data. Contact @ 0x419107d8 Unknown, System Class 56 2,094 480 7.45%
1171 305,816 (retained size) > [ android.graphics.Bitrnap @ Ox41288b50 48 1,127,584 4.01%
o no GC root S| com.android.mms.ui.MessagelistView @ 0x4223eaf0 952 680,768 242%
> [ com.android.mms.ui.Messagelistitern @ 0x4236e3b0 624 664,560 2.37%
Statics | Attributes| 7z rd o D com.android.mms.ui.Messagelistitern @ 0:4210e3e0 824 663,912 2.36%
=] MName Value L S| com.andro?d.mms.u?.MessageL?sﬂtem @ 042120298 624 663,912 2.36%
X > [] com.android.mms.ui.Messagelistltern @ 0:427528c0 624 663,912 2.36%
ref mWorking... com.android . [] com.android.mms.ui.MessageListitern @ 0x428876f8 624 663,744 2.36%
ref  mWaitingl...  java.lang.Obj . [] com.android.mms.uilmageAttachmentView @ 0x12417668 528 639,056 2.97%
ref mURLs java.util.Array . [0 android.widgetImageView @ 0x421b£550 416 627,616 2.23%
ref mTopTitle null > [ 32 499,416 1.78%
ref mTopSubt..  null > [ 608 305,816 1.09%
ref mActionB...  null - [ 608 305,816 1.09%
ref mAddCeon... null e I 608 305,816 1.09%
ref mTopPanel android.widg 7 > [ eo .andreid.mms.ui.ComposeMessagefctivity @ 0x41c7d570 608 305,816 1.09% L
1 L | ' > [ .android.mms.ui.ComposeMessageictivity @ 0x41def6f0 608 305,816 1.09% 3
L7 Mawvigation History 23 = O > D 608 305,816 1.09%
. - - [ 608 305,816 1.09%
4 1 OverviewPane - O 608 305,816 1.09%
4 'Eg dominator_tree > [ 608 225,056 0.80%
> D COMm. androld mms.ui.Recipie & 848 220,672 0.79%
> | android.graphics.NinePatch @ 0x419fe6da 32 218,992 0.78%
| com.android.mms.ui.RecipientsEditor @ Oxd256aded 848 198,384 0.71%
¢ o > D Java.util.jarJarFile @ 0x4198c9e0 48 182,344 0.65%
| histogram ) > | com.android.mms.ui.RecipientsEditor @ 0x422d6638 848 170,568 0.61%
default_report org.eclipsemal || [ com.android.mms.isms.ui.view.NmsEmoticonPanel @ 0x4238f50 664 162,672 0.58%
%3 dominator_tree o D com.android.mms.ui.RecipientsEditor @ Oxd2cbacld 848 156,568 0.56%
4 il histogram . [ com.android.mms.ui.RecipientsEditor @ 0wl 2chTbed 848 156,312 0.56%
| com.android.mms.ui.MessagelistView @ 0x42ead6d8 952 148,080 0.53%
> [] andreid.graphics.Bitmap @ 0x41954330 45 129,664 0.46%
[ J,a class andreid.text.HtrlSHtmIParser @ 0x411b8530 System Class 8 126,632 0.45%%
| com.andreid.mms.ui.MessagelistView @ 0x41970b0 952 112,368 0.40%
> ] andreid.graphics.Bitmap @ 0x4129d5f0 45 100,288 0.36% i
s D com.android.il8n.phonenumbers.PhoneMumberUtil @ 0:41986c58 40 93,320 0.33%
> |1 android.graphics.Bitmap @ 0x4198a4f3 43 92,224 0.33%
> [ javalang.ref.FinalizerReference @ 0x418c5648 40 84,400 0.30%
» If1 class arn.anache harmonv.securit fortress Services @ (1133478 Sustem Class 32 80120 0.29%
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Dominator Tree

= From this list we can find potential leaked object, so many instances of
‘ComposeMessageActivity’ for this case, it's abnormal.

= Right click on it and select:

- List Objects > with incoming references: Shows objects that have an incoming
reference to the selected object. If there is a class that has many unwanted
iInstances it is good practice to find incoming references that are keeping it from
being GC.

= Path To GC Roots > exclude weak/soft references: Shows the reference path
from the object to GC roots excluding weak/soft references

- Merge Shortest Paths to GC Roots — Finds the common paths from garbage
collection roots to an object or a set of objects.

PAGE 37 80-NJ221-1 A Jul 2013 Confidential and Proprietary — Qualcomm Technologies, Inc. | MAY CONTAIN U.S. AND INTERNATIONAL EXPORT CONTROLLED INFORMATION



Dominator Tree

= Right click on it and select:
- Show Retained Set - Calculates the retained set of an arbitrary set of objects.

- Java Basics > Class Loader Explorer: Show the defined classes and the
number of live instances. If one and the same component is loaded multiple
times, the number of live instances can indicate which class loaders is more
alive and which one should be garbage collected
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What to Do?

= Perhaps it's because the ‘mBackgroundQueryHandler’ hasn’t be released
before this activity is finished which cause this activity can’t be released.

File Edit Mawvigate Search Project Run Window Help

O o~ B8 2 Q- = - o - vl = Quick Access [ ﬁl Jlava #ZH DDMS E Memory Analys
[EL Inspector 22 . = B || [X] MainActivity.java 2 android240576570741260554 . hprof 2 | B2 android1373813633317141066.hprof 2 android507078783642344019. hprof = &
@ 042501018 i Ml Fs o [l >~ & ~| O | E - & | &l

[[] ComposeMessagedctivity N

H com.andreid.mms.ui i Owerview %3 dominator_tree | =g path2gc [;electlon of ' Compc\seMess [¥] list_objects [selection of 'Compose... | [F] list_objects [selection of 'Messagel... =32
A2 class com.android.mms.ui.Compoes... Class Mame Shallow Heap  Retained Heap *
@s android.app.Activity He <Regex> =Mumeric> =Mumeric
2] dalvik.system.PathClassLoader @ Ox... 4 [ com.android.mms.ui.MessageListView @ 0x4223eaf0 a52 680,76
I 608 (shallow size) > M7 this$0 androidowiew ViewGroups3 @ 0x412336290 16 1
1071 3,864 (retained size) . T referent java.lang.ref. WeakReference @ 0x:4233508 24 2
o no GCroot > D referent java.lang.ref. WeakReference @ 0x4236fbb0 24 2
. Tdl [0] android.view. View[12] @ 0:423cb5b8 54 &
Statics | Attributes | **2 - > D host android.view ViewS5crollabilityCache @ 0x4245b8e8 72 36
Type Mame walue L > D mCaller android.view.InputEventConsistencyVerifier @ O 248700 a0 15
. . a T mMsglListView com.andreid.mms.uiComposeMessagefctivity @ 042591018 603 3,86
ref mWarking...  com.android - T mContext android.widget ScrollView @ 0x41925998 568 215
ref mWaitingl..  java.lang.Obj— - 7] this$0 com.andr amposeMessageActivity$45 @ Oxd1afad7o 16 1
ref mURLs Java.util. Array s T this$0 ctivitySBackgroundQuenyHandler @ 0x41fbb320 48 10|=
ref mTopTitle null WorkerHandler @ 0x421a6a78 32 3
ref mTopSubt.. null 608 3,86
ref mActionB... null NwmContext android.widget. ScrollVlew Feicd1925998 568 215
ref maddCon...  null L aclroid. oo PosehMessagelctivity$45 @ 0x41af2d70 16 1
ref mTopPanel android.widg ™ - T this$0 com.andreid.mms.ui.CompeoseMessageActivity$Background QueryHandler @ 0:1fbb320 48 10
bl L 5 . T this$o com.android.mms.ui.Composebessagefctivity$2 @ 0x4200caal 16 1
B Mavigation History 52 = 9 . T this$o com.android.mms.ui.ComposeMessagefctivity$3 @ 0x42194960 15 1
- - > D mCallback, mContext com.android.internal. policy.impl.PhoneWindow @ 0x421 ef2d8 232 8,24
< 1 OwerviewPans “ . 7] mContest android.widget. TextView @ 0x4221800 616 1,08
4 g dominater_tree . ] this$0 com.android.mms.ui.ComposeMessagefctivityS46 @ 0x42218af0 16 1
s D mContext android.widget.ImageButton @ 0:x42218b20 416 2,80
. T this$o com.android.mms.ui.ComposeMessagefctivity$23 @ 0x4221ff68 24 2 .
= D mContext com.android.internal.widget.ActionBarContextView @ 0x4 222903 536 1,01
- T thiss0 com.android.mmes.ui.ComposeMessagefctivityS4 @ 0x42235170 16 1
. T mContext android.view. ViewStub @ 0x42237550 352 52
- - T mContext android.widget.Button @ 04223738 616 94
> D mContext android.view. View @ 0x422309278 336 76
> D mContext com.android.mms.ui.MessagelistView @ 0x4223eafl 952 680,76
> D mContext android.widget.RadioButton @ 0x42240510 G40 1.44
. 7] mContesxt android.widget.LinearLayout @ 0x4224e398 512 1,59
» D mContext android.view. ViewStub @ 0x4224F8F8 352 52
> D mContext, mContext com.android.mms.ui.MessagelistAdapter @ 0x422514f0 88 52
. 7] mContesxt android.widget.Framelayout @ 0x42251a50 106 1,24
7] tist_objects [seiection of - | mContext com.android.mms.isms.ui.view.MmsEmoticonPreview @ 0x42253270 40 1,63
il histogram e > D mContext com.android.internal.view.menu.ActionhfMenuView @ 0x42257acl 544 112
default_report org.eclipse.
> D mContext android.widget. Image‘u"lew @ 04 225df80 416 90
Anminatnr tree - - . - R -
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What to Do?

= Use the Regex filter to find ‘ComposeMessageActivity’ objects inside the

Histogram view.

There are 23 instances of ‘ComposeMessageActivity’.

[ £ | @ Java @ DDMS [E3, Memory Analysi

File Edit Mavigate Search Project Run  Window Help
£~ pB 2 Q- = > o Vl gl Quick Access
=4 Inspector &3 4:5 = O [J] MainActivity.java 8 android240576570741260554 . hprof 22 ]_

@ 0541ac5090

LAE] ComposeMessageActivity

# com.android.mms.ui

[E] class java.lang.Class @ 0x410341e8
@Sandroid.app.Activity

18] dalvik.system.PathClassLoader @ Ox...

512 (shallow size)
4,080 (retained size)
o GC root: Unknown, Systermn Class

4 e

Statics | Attributes | % -
Type Mame

ref SstaticOve.
int CHANGE....
int CHARS_RE...

ref CREATE_M... 0O

ref CREATE_M... 2

ref CREATE M. 1

bool.. DEBUG false

bool.. DEFER LO.. true S
« m O
B Mavigation History &2 = Od
a 1 OverviewPane -

a ?g dominator_tree
L)

FEEFOPPsRBPISE

a Nl histogram
a [F| list_objects [selection of

PAGE 40 80-NJ221-1 A Jul 2013

=
il e al B E-R| QS E | &

i Owverview % default_report org.eclipse.rgt.api:suispect; ‘E domina’t’:’orﬁtreel ||7| Histogram &3 |a list_cbjects [selection of "byte[]'] -inbound

Class sl Objects Shallow Heap Retained Heap
ﬁb.*ComposeMessageAct'rvity.* \ = Mfneric> =Mumeric> =Mumeric>
s ndroid. oseMessagefiah L 23 p | 13984  >=2731144 :
@ com.android.mme.ui.ComposeMessageActivitySBackgroundQueryHandler Ndi” 1,104 >z 2,302
@ com.android.mms.ui.ComposeMessageActivity§11 23 736 =736
@ com.android.mms.ui. ComposeMessagefctivityS8 23 736 »= 736
@ com.android.mms.ui.ComposeMessagelctivity$1 22 736 >=T736
& com.android.mms.ui.ComposeMessagehctivity$23 24 576 >= 576
& com.android.mms.ui.ComposeMessagehctivity$19 23 552 == 552
& com.android.mms.ui.ComposeMessagedctivity$45 23 368 == 368
[c] com.android.mms.ui.ComposeMessagefctivity 54 23 368 == 368
@ com.android.mms.ui.ComposeMessageActivity$28 23 368 >= 368
@ com.android.mms.ui.ComposeMessageActivity$48 23 368 »= 368
@ com.android.mms.ui. ComposeMessagefctivity514 23 368 »= 368
@ com.android.mms.ui.ComposeMessagelctivity$46 22 368 >= 368
& com.android.mms.ui.ComposeMessagehctivity$54 23 368 >= 368
@ com.android.mms.ui.ComposeMessagehctivitys3 23 368 >= 368
@ com.android.mms.ui.ComposeMessageActivity$2 23 368 == 368
[c] com.android.mms.ui.ComposeMessageActivity544 23 368 == 368
@ com.android.mms.ui.ComposeMessageActivity§13 23 368 >= 368
@ com.android.mms.ui.ComposeMessageActivity$43 23 368 »= 368
@ com.android.mms.ui. ComposeMessagefctivity515 23 368 »= 368
@ com.android.mms.ui.ComposeMessagelctivity$12 22 368 >= 368
& com.android.mms.ui.ComposeMessagehctivity$36 23 368 >= 368
& com.android.mms.ui.ComposeMessagehctivity$20 5 80 == &0
& com.android.mms.ui.ComposeMessageActivity$21 5 80 == &0
[c] com.android.mms.ui.ComposeMessageActivity522 [} 0
@ com.android.mms.ui.ComposeMessageActivitySMsgListMenuClickListener 0 0
@& com.android.mms.ui.ComposeMessageActivity$29 0 0
[c] com.android.mms.ui.ComposeMessageActivitySDeleteMessagelistener a [}
@ com.android.mms.ui.ComposeMessagelctivity$16 0 0
& com.android.mms.ui.ComposeMessagehctivity$17 0 0
& com.android.mms.ui.ComposeMessagehctivity$27 0 0
& com.android.mms.ui.ComposeMessageActivity$24 0 0
[c] com.android.mms.ui.ComposeMessageActivitySDeleteMessagelistenersl [} 0
@ com.android.mms.ui.ComposeMessagefctivity$47 0 0
@ com.android.mms.ui.CompaseMessageActivitySBackgroundQueryHandlersl 0 0
[c] com.android.mms.ui.ComposeMessagefctivityS51 a [}
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What to Do?

= What we can do now is just check the related code to see if there are any
bugs.

= Refer to [R5] for Android Memory Leaks and the solutions.

= To avoid context-related memory leaks, remember the followings:

= Do not keep long-lived references to a context-activity (a reference to an activity
should have the same life cycle as the activity itself)

= Try using the context-application instead of a context-activity

= Avoid non-static inner classes in an activity if you don't control their life cycle,
use a static inner class and make a weak reference to the activity inside.

= A garbage collector is not an insurance against memory leaks.
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Detecting a Memory Leak
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Check the logcat Output Message

= Your application crashes with an ‘Out of memory’ error after running for a
long time.

= You can see frequent GC_ lines in logcat before the crash.

D/dalvikvm( 1325): GC_CONCURRENT freed 1971K,
18% free 12382?,4983& paused 3ms+/ms /

Heap statistics

Reason for garbage
collection:

e bb BN L
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Check the logcat Output Message

= Out of memory message from the logcat output:

I/dalvikvm-heap( 3088): Clamp target GC heap from 103.616MB to 96.000MB

D/dalvikvm( 3088): GC CONCURRENT freed 165K, 1% free 97769K/98148K,
paused 7ms+80ms, total 483ms

D/dalvikvm( 3088): WAIT_FOR_CONCURRENT_GC blocked 147ms

I/dalvikvm-heap( 3088): Forcing collection of SoftReferences for 376296-byte
allocation

I/dalvikvm-heap( 3088): Clamp target GC heap from 103.600MB to 96.000MB

D/dalvikvm( 3088): GC BEFORE OOM freed 16K, 1% free 97753K/98148K,
paused 392ms, total 392ms

E/dalvikvm-heap( 3088): Out of memory on a 376296-byte allocation
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Check the logcat Output Message

D/dalvikvm( 3088): GC CONCURRENT freed 165K, 1% free
97769K/98148K, paused 7ms+80ms, total 483ms

The first part of message indicates the type of GC (reason of GC). There are
four different types:

Invoked when the heap gets too large to prevent

GC CONCURRENT
— overflow.

Invoked when GC_CONCURENT was not run on
GC_FOR_MALLOC time and the application had to allocate more
memory.

Used before Honeycomb for freeing external
GC_EXTERNAL_ALLOC | allocated memory. In Honeycomb and higher there is
no external allocation.

GC_EXPLICIT Invoked when System.gc is called.
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Check the logcat Output Message

D/dalvikvm( 3088): GC CONCURRENT freed 165K, 1% free
97769K/98148K, paused 7ms+80ms, total 483ms

« “freed 165K” — indicates how much memory is freed.

= “1% free 97769K/98148K” — indicates the percentage of free memory left,
the size of live objects and the total heap size.

= “paused 7ms+80ms” — indicates how much time it takes the GC to finish
collection.

With this information, it is possible to tell after a few collections if the GC
successfully frees the memory. If the allocated memory does not go down
after some period of time (and keeps growing), it is clear that there is a
memory leak.

PAGE 46 80-NJ221-1 A Jul 2013 Confidential and Proprietary — Qualcomm Technologies, Inc. | MAY CONTAIN U.S. AND INTERNATIONAL EXPORT CONTROLLED INFORMATION



Check the logcat Output Message

E/dalvikvm-heap( 3088): Out of memory on a 376296-byte allocation

When the available resources are exhausted, an OutOfMemoryError
exception is thrown. It may indicate that there is a memory leak. This
method is not the best way to know if there is a leak as the exception may
occur when the developer tries to allocate a large amount of memory (ex.
bitmap) and the total heap size will exceed the platform limit. It surely
Indicates that the developer should rethink his memory management
method.
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Comparing Heap Dumps with MAT

- When debugging memory leaks, sometimes it's useful to compare the
heap state at two different points in time. To do this, you'll need to:

- Create two separate HPROF files (don't forget to convert them using hprof-
conv).

= Open the first HPROF file (using File > Open Heap Dump).
= Open the Histogram view.

= In the Navigation History view (use Window > Navigation History if it's not
visible), right click on histogram and select Add to Compare Basket.

= Open the second HPROF file and repeat steps 2 and 3.

= Switch to the Compare Basket view, and click Compare the Results (the red "!"
icon in the top right corner of the view).
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Comparing Heap Dumps with MAT

= Compare the number of instances and sizes of each type of object
between the two snapshots.

= An unexplained increase in the number of objects may indicate a leak!
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Useful Information
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ServiceConnection Leak

= Usually ServiceConnection leak is caused by client try to bind to service
but the service still not ready. For example, the service hasn’t been started
or the service can't be started successfully.
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06-13 10:23:15.672 W/ActivityManager( 654): Unable to start service Intent { act=com.zte.zgesture.lGestureService }: not found
06-13 10:23:15.762 E/ActivityThread( 1009): Activity com.android.phone.InCallScreen has leaked ServiceConnection android.view.ViewRootGestureDispatcher$1@41e2e730

that was originally bound here

06-13 10:23:15.762 E/ActivityThread( 1009): android.app.ServiceConnectionLeaked: Activity com.android.phone.InCallScreen has |leaked ServiceConnection
android.view.ViewRootGestureDispatcher$1@41e2e730 that was originally bound here

06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):
)06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):
06-13 10:23:15.762 E/ActivityThread( 1009):

at android.app.LoadedApk$ServiceDispatcher.<init>(LoadedApk.java:969)

at android.app.LoadedApk.getServiceDispatcher(LoadedApk.java:863

at android.app.Contextimpl.bindService(Contextimpl.java:1263)

at android.app.Contextimpl.bindService(Contextimpl.java:1255)

at android.content.ContextWrapper.bindService(ContextWrapper.java:394)

at android.view.ViewRootGestureDispatcher.<init>(ViewRootGestureDispatcher.java:32)
at android.view.ViewRootimpl.<init>(ViewRootlmpl.java:415)

at android.view.WindowManagerimpl.addView(WindowManagerimpl.java:300)

at android.view.WindowManagerimpl.addView(WindowManagerimpl.java:232)

at android.view.WindowManagerimpl$CompatModeWrapper.addView(WindowManagerlmpl.java:149)
at android.view.Window$LocalWindowManager.addView(Window.java:547)

at android.app.ActivityThread.handleResumeActivity(ActivityThread.java:2641)

at android.app.ActivityThread.handleLaunchActivity(ActivityThread.java:2092)

at android.app.ActivityThread.access$600(ActivityThread.java:133)

at android.app.ActivityThread$H.handleMessage(ActivityThread.java:1198)

at android.os.Handler.dispatchMessage(Handler.java:99)

at android.os.Looper.loop(Looper.java:137)

at android.app.ActivityThread.main(ActivityThread.java:4777)

at java.lang.reflect.Method.invokeNative(Native Method)

at java.lang.reflect.Method.invoke(Method.java:511)

at com.android.internal.os.Zygotelnit$MethodAndArgsCaller.run(Zygotelnit.java: 789)
at com.android.internal.os.Zygotelnit.main(Zygotelnit.java:556)

at dalvik.system.NativeStart.main(Native Method)

06-13 10:23:15.762 W/ActivityManager( 654): Unbind failed: could not find connection for android.os.BinderProxy@42127e18
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StrictMode

- Enable ‘StrictMode’ also can find some object leak.
= Please refer to [R10] for more information about ‘StrictMode’
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Questions?

https://support.cdmatech.com
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